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This tutorial applies to both the text-based Emacs, where all commands are executed with
keystrokes, and the newer version which supports a graphical user interface. The graphical version
supports a mouse interface, menu bar, scroll bars, and other features. These are available only on X
displays.  If you are not familiar with this sort of interface refer to appendix A.

Emacs Defined
Emacs is a self-documenting, customizable, extensible, real-time display editor. Emacs is clas-

sified as a display editor because it displays the contents of a file as it’s typed rather than requiring
a special command to view the contents. It is real-time because the screen updates as each character
is typed. Changes can be seen immediately as they are input. We call Emacs self-documenting since
its complete documentation is built-in and is available at any time with just a keystroke (C-h).
Emacs is customizable and extensible because commands can be re-mapped to different keystrokes,
and new commands can be created and added to its basic functionality. Because the source to GNU
Emacs is freely-distributed, its flexibility is further enhanced.

Emacs is found on a variety of operating systems and architectures, most notably on UNIX
and VMS machines. The particular variety of Emacs we will be discussing in this document is GNU
Emacs (version 19), a widely-installed distribution of Emacs from the Free Software Foundation.

Conventions Used in this Document
Each section has two accompanying labs. Labs that are labeled with a  (text icon) describe

procedures and commands for the text-based version of Emacs while labs marked by a  (mouse
icon) describe the mouse-based version. We suggest working through the text lab first then the
mouse-based lab second in each of the sections. Emacs commands are shown in bold italic type
throughout this document.

How Emacs Interacts with Files
Emacs, as with editors in general, does not directly access a file’s contents. Instead, Emacs

copies the contents of the file into a buffer (see right side bar). A buffer is a temporary work area
where Emacs allows you to edit a text file. The real file is left untouched as a backup until Emacs is
given the explicit command to save the buffer upon which time the changes are saved permanently.

Emacs also supports the “version” capability of the operating system on which it resides. For
instance, on UNIX, the previous edition of a file exists as the filename appended with a tilde (~). On
VMS, there can be many backup versions of a file, such as FILE.TXT;1, FILE.TXT;2, and
FILE.TXT;3, where version 3 is the most recent.

1

INTRODUCTION SAMPLE.TXT
Retrieving the sample.txt Text File

If you already have a file named
sample.txt you may want to rename it before
continuing.

The following boldfaced commands il-
lustrate the process to transfer the sample.txt
file from the bu.edu archive to your home di-
rectory. Note that the password should con-
tain your login name as well as the current host
name.

host% ftp bu.eduftp bu.eduftp bu.eduftp bu.eduftp bu.edu
Connected to bu.edu.
220 bu.edu FTP server ready.
Name (ftp.bu.edu:tutor1): anonymousanonymousanonymousanonymousanonymous
331 Guest login ok
Password: your_login_name@host_nameyour_login_name@host_nameyour_login_name@host_nameyour_login_name@host_nameyour_login_name@host_name
230 Guest login ok restrictions apply.
ftp> cd /examples/emacs cd /examples/emacs cd /examples/emacs cd /examples/emacs cd /examples/emacs
250 CWD command successful.
ftp> get sample.txt get sample.txt get sample.txt get sample.txt get sample.txt
200 PORT command successful.

The machine will transfer the sample.txt
file to your account now. After transferring the
file logout from the ftp server as shown be-
low.

226 Transfer complete.
915 bytes received in 0.4 seconds
ftp> byebyebyebyebye
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THE EMACS DISPLAY

MINOR MODES
Displays the current minor mode as listed below:

Abbrev mode ................ allows for use of word abbreviations
Fill mode .................................................. enables word wrap
Overwrite mode .... replaces characters rather than inserting
Auto-save mode ...... saves file every 300 keystrokes (default) 3

MODE LINE
Displays information about the

buffer name and the major and minor modes. BUFFER DISPLAY
Shows what percentage of the buffer is displayed:
All .......... the entire buffer is visible on screen
Top ..... cursor is at the beginning of the buffer
Bot ............... cursor is at the end of the buffer
50% .............. cursor is at middle of the buffer

MAJOR MODES
Displays the current

major modes as described below:
Fundamental mode ................................... the default mode
Text mode ..................................................... for writing text
Indented text mode ...................................... indents all text
Picture mode .................. for creating simple line drawings
C mode .......................................... for writing C programs
FORTRAN mode.............. for writing FORTRAN programs
Emacs LISP mode ....... for writing EMACS LISP functions
LISP mode ................................ for writing LISP programs
LISP interaction mode........ writing/evaluating expressions
nroff mode ................................ for formatting files in nroff
TeX mode ................................... for formatting files in TeX
LaTeX .................................... for formatting files in LaTeX
Scribe mode ........................... for formatting files in Scribe
Outline mode ........................................ for writing outlines
View mode ......................... for viewing files but not editing

SCROLL BAR (X version only)
Left click to scroll to the top of a buffer,
right click to scroll to the bottom, and

middle click/drag for elevator scrolling.

TEXT WINDOW
Displays the current section of the open file.

CURSOR
The point of insertion and deletion.

FRAME
Each Emacs window is called a frame. Multiple
frames are only available when working in an X

environment.

The Emacs display consists of several parts: the text window, mini-buffer (also called the echo
area), mode line, menu bar (X version only) and the frame. The Emacs image on your particular
screen might not look exactly like the diagram below because of your particular environment. If you
are using Emacs in an X environment rather than via an ascii terminal then your display will more
closely resemble the diagram. In either case, X environment or ascii terminal, all of the Emacs
commands are available from the keyboard. The text window is the area which displays the current
section of the open buffer. The last
line of the text window is called the
mode line and is displayed in re-
verse video.

Directly underneath the mode
line, on the last line of the entire
Emacs display, is the mini-buffer.
When the first keystroke of a key
sequence that requires a second
keystroke has been entered, the cur-
sor moves to the mini-buffer to
prompt for the rest of the command.
To cancel a command in progress,
type C-g.

The entire Emacs display is
contained within a frame. When us-
ing the X version multiple frames
can be activated.

MINI–BUFFER
Displays & prompts for

commands requiring two keystrokes.

FILE STATUS
Indicates the status of the current file and buffer:

** ................................ modifications
-- ............................ no modifications
%% ........................ read-only access

BUFFER NAME
Displays the name of the current buffer.

EMACS QUICK LIST
Use C-x p to toggle on/off this

list of commonly used commands

MENU BAR (X version only)
Pull-down menus provide a graphical

interface for many of the standard Emacs commands.
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MOVING AROUND
Lab 1, part 2 shows how to move around within the Emacs text buffer. See “Appendix A:

Using the Mouse” if you are not familiar with the operation of a graphical user interface before
completing this lab. The cursor, sometimes called a point, is the point of insertion and the point of
deletion. In other words, when characters are typed they appear at the location of the cursor and
when the backspace key is typed, characters will disappear from the location immediately left of the
cursor.

To insert and delete characters, it is necessary to move the cursor to the desired location in the
text buffer. The following lab utilizes the most commonly used commands for changing the location
of the cursor. Lisp function names, which have been bound to the keystrokes are also listed. To
notify Emacs that a Lisp function name has been input rather than a keystroke type M-x before the
Lisp function name. For example, to move forward one character using the Lisp function name
rather than C-f, type: M-x forward-char. For a more complete list of Lisp function names obtain a
copy of the Emacs Reference Card from the Office of Information Technology or refer to appendix
B of this document.

5

Emacs contains many commands allowing for
easy and quick traversal of the text buffer.

Lab 1, Part 2
Moving Around

• Edit the file sample.txt by entering
  emacs sample.txt at the UNIX prompt and
  press the return key.
• Practice moving forward and backward, from
  one line to the next, and to the beginning and
  end of the buffer. Use the table of commands
  below:

Description Lisp Function Name
C-f next character forward-char
C-b previous character backward-char
C-n next line next-line
C-p previous line previous-line
C-e end of line end-of-line
C-a beginning of line beginning-of-line
M-> end of buffer end-of-buffer
M-< beginning of buffer beginning-of-buffer
C-v forward one screen scroll-up
M-v back one screen scroll-down

• Edit the file sample.txt by entering
  emacs sample.txt at the UNIX prompt and
  press the return key.
• Using the mouse position the on-screen I-beam
  some place in the text buffer.
• Click the mouse button to move the cursor to
  this new location in the buffer.
• Practice moving the cursor to various locations
  in the buffer.
• Move the mouse to position the on-screen
  pointer over the scroll bars and practice
  scrolling through the text buffer:

Left click scrolling (scroll down)
Right click scrolling (scroll up)
Center drag scrolling (elevator scroll)
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MOVING TEXT & UNDOING CHANGES

7

This lab demonstrates how to move a marked block of text to a new location within the buffer.
Moving text from one location to another is accomplished in a two-set process using the kill and
yank commands. The kill command removes the marked text placing it in the kill ring where it can
be accessed by the yank command and pasted back into the buffer. Text is pasted into the buffer at
the location of the cursor when the yank command is executed.

For a summary of moving and undoing commands see appendix B.

• Move the first 2 lines of text to the 150th line in
  the buffer. You will need to mark and kill the
  first 2 lines. See the previous lab for assistance.
• Move the cursor to the correct location using
  M-149 then C-n to repeat the next-line
  command 149 times.
• Yank back the last killed text (the 2 lines which
  you killed from the beginning of the buffer)
  using the C-y command.
• Practice using the undo command, C-x u, to
  cancel the changes.

Lab 2, Part 1
Moving Text &
Undoing Changes

• Move the first 2 lines of text to the 150th line in
  the buffer. You will need to mark and kill the
  first 2 lines. See the previous lab for assistance.
• Move the cursor to the correct location by
  scrolling down the text buffer. It may help to
  locate the correct line by turning on line-
  number-mode with the command M-x line-
  number-mode. However, this is an example of
  a situation when keyboard commands are better
  suited to the task than the mouse.
• Yank back the last killed text (the 2 lines which
  you killed from the beginning of the buffer)
  by selecting Paste from the Edit menu.
• Practice using the Undo command. It is located
  in the Edit menu.

It is a good idea to save your files (C-x C-s)
every 10 or 15 minutes to help prevent losing
important data.

!
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BUFFERS & FRAMES

9

Frames
Every Emacs session is displayed within

a frame. This is the “window” on-screen which
displays the Emacs application (text buffer,
menu, mini-buffer, mode line, etc.). When
using Emacs in an X environment it is pos-
sible to edit several files at the same time by
invoking the frames with an ampersand (&),
for example, at the UNIX prompt enter emacs
filename & and press the return key, then en-
ter emacs filename & again and press the re-
turn key. You will see two separate frames,
each editting the same file. Each frame is dis-

played in its own X window. Only a single
frame is allowed in the text based version of
Emacs, however, there is a method which al-
lows for editting more than one file in the
single frame.

Working with Multiple Buffers
All Emacs frames can display multiple

files by spliting the text buffer into sections.
Emacs has several commands used to create
and remove buffers. The active buffer is al-
ways determined by the location of the cur-

sor. Lab 3 demonstrates how to create, remove,
and switch between buffers.

Inserting Files Into Buffers
Files can be combined inside the text

buffer by using the insert-file command. The
inserted file is placed at the location of the
cursor when the command was executed. The
mini-buffer will prompt for the name of the
file to be inserted. Emacs leaves the cursor at
its original location once the file is inserted.

Lab 3
Buffers & Frames

• Append the file /etc/motd to the end of the file
  sample.txt with the command C-x i. The mini-
  buffer prompts for a filename, type /etc/motd
  and press the return key.
• Edit a new file called sample1.txt by entering
  C-x C-f sample1.txt and press the return key.
• Exit Emacs by entering C-x C-c then restart
  with the file sample.txt, emacs sample.txt, and
  press the return key.
• Split the buffer into two halves by entering the
  command C-x 2.
• Edit a different file (sample1.txt) in this new
  buffer by reading the file with C-x C-f.
  Remember that the cursor’s location dictates
  which window is active.
• Use C-x o to move the cursor from one buffer
  to the other.
• Make the current buffer consume the whole
  screen with the command C-x 1.
• Use C-x b to switch back to the other buffer.
• Close all of the open buffers and exit Emacs by
  entering C-x C-c.

Most of Emacs’ buffer commands are not
available from the menu bar. However, the menu
bar does allow for easy selection of various
buffers.

• Select the desired buffer by selecting its name
  from the Buffers menu. To see a list of buffers
  select List All Buffers from the Buffers menu.

• To switch between buffers simply move the
  cursor to the desired buffer. All commands
  affect the active buffer, i.e., the buffer where the
  cursor is currently located.

• Select Kill Buffer  from the File menu to
  remove a buffer from the screen.



?

M
O

R
E

 H
E

LP
O

n-
Li

ne E
m

ac
s 

pr
ov

id
es

 e
xt

en
si

ve
 h

el
p 

fe
at

ur
es

 w
hi

ch
 r

ev
ol

ve
 a

ro
un

d 
a 

si
ng

le
 c

ha
ra

ct
er

, 
C

-h
. C

-h
 is

th
e 

pr
ef

ix
 k

ey
 fo

r 
al

l t
he

 h
el

p 
co

m
m

an
ds

. T
he

 m
os

t u
se

fu
l h

el
p 

se
qu

en
ce

 is
 

C
-h

 C
-h

, w
hi

ch
 p

rin
ts

 a
lis

t 
of

 a
ll 

th
e 

po
ss

ib
le

 h
el

p 
op

tio
ns

 a
nd

 t
he

n 
pr

om
pt

s 
fo

r 
w

hi
ch

 o
pt

io
n 

yo
u 

w
ou

ld
 l

ik
e 

to
 s

el
ec

t.
Ty

pi
ng

 a
 th

ird
 C

-h
 p

rin
ts

 a
 d

ef
in

iti
on

 o
f e

ac
h 

of
 th

e 
op

tio
ns

. L
ab

 4
 d

em
on

st
ra

te
s 

ho
w

 to
 u

se
 s

om
e 

of
th

e 
he

lp
 c

om
m

an
ds

.
T

he
 v

er
y 

be
st

 w
ay

 to
 le

ar
n 

an
y 

ap
pl

ic
at

io
n 

pr
og

ra
m

 is
 b

y 
us

in
g 

it.
 T

yp
e 

C
-h

 t,
 o

r 
se

le
ct

 E
m

ac
s

Tu
to

ria
l f

ro
m

 th
e H

el
p 

M
en

u,
 to

 s
ta

rt
 a

 c
om

pr
eh

en
si

ve
, s

el
f-

pa
ce

d 
E

m
ac

s 
tu

to
ria

l w
hi

ch
 w

ill
 p

ro
-

vi
de

 v
al

ua
bl

e 
ha

nd
s-

on
 e

xp
er

ie
nc

e 
us

in
g 

th
e 

co
m

m
an

ds
 d

es
cr

ib
ed

 in
 th

is
 h

an
do

ut
 a

s 
m

an
y 

ot
he

rs
.

N
ot

 O
n-

Li
ne

T
he

 G
N

U
 E

m
a

cs
 M

a
n

u
a

l, b
y 

R
ic

ha
rd

 S
ta

llm
an

, i
s 

co
ns

id
er

ed
 th

e 
de

fin
iti

ve
 E

m
ac

s 
do

cu
m

en
t.

It 
is

 a
va

ila
bl

e 
at

 a
 n

om
in

al
 f

ee
 f

ro
m

 t
he

 F
re

e 
S

of
tw

ar
e 

F
ou

nd
at

io
n,

 6
75

 M
as

sa
ch

us
et

ts
 A

ve
nu

e,
C

am
br

id
ge

, M
A

, 0
21

39
. T

he
 m

an
ua

l a
ls

o 
co

nt
ai

ns
 a

 h
an

dy
 q

ui
ck

 r
ef

er
en

ce
 c

ar
d.

 F
or

 a
dd

ed
 c

on
ve

-
ni

en
ce

, 
In

fo
rm

at
io

n 
Te

ch
no

lo
gy

 s
el

ls
 t

he
 m

an
ua

l f
or

 
$ 1

5,
 a

nd
 t

he
 q

ui
ck

 r
ef

er
en

ce
 c

ar
d 

is
 a

va
ila

bl
e

fr
om

 th
e 

IT
 H

el
p 

D
es

k.
A

s 
w

ith
 a

ny
 U

N
IX

 a
pp

lic
at

io
n 

in
st

al
le

d 
on

 a
n 

In
fo

rm
at

io
n 

Te
ch

no
lo

gy
 s

up
po

rt
ed

 m
ac

hi
ne

,
w

he
n 

yo
u 

ca
n 

no
 lo

ng
er

 fi
nd

 h
el

p 
on

 y
ou

r 
ow

n,
 p

le
as

e 
co

nt
ac

t y
ou

r 
de

pa
rt

m
en

ta
l c

on
su

lta
nt

 o
r 

se
nd

em
ai

l t
o 

he
lp

@
yo

ur
 m

ac
hi

ne
 n

am
e.

La
b 

4
G

et
tin

g 
O

n-
lin

e 
H

el
p

• 
F

in
d 

al
l c

om
m

an
ds

 w
hi

ch
 c

on
ta

in
 th

e 
w

or
d

  “
w

in
do

w
”.

 T
yp

e 
C

-h
 a

 to
 in

vo
ke

 c
om

m
an

d-
  a

pr
op

os
. T

he
 m

in
i-b

uf
fe

r 
w

ill
 p

ro
m

pt
 fo

r 
a

  k
ey

w
or

d,
 ty

pe
 w
in

do
w

 a
nd

 pr
es

s 
th

e 
re

tu
rn

  k
ey

.
• 

F
in

d 
th

e 
na

m
e 

an
d 

de
sc

rip
tio

n 
of

 a
 fu

nc
tio

n
  w

hi
ch

 is
 b

ou
nd

 to
 a

 k
ey

 s
eq

ue
nc

e 
us

in
g 

th
e

  c
om

m
an

d,
 C
-h

 k
. T

he
 m

in
i-b

uf
fe

r 
w

ill
 p

ro
m

pt
  f

or
 a

 k
ey

, e
nt

er
 a

 k
ey

 fr
om

 th
e 

ke
yb

oa
rd a

nd
  p

re
ss

 th
e 

re
tu

rn
 k

ey.
• 

U
se

 th
e 

co
m

m
an

d C
-x

 p
 to

 d
is

pl
ay

 th
e 

qu
ic

k
  l

is
t.

• 
F

in
d 

al
l c

om
m

an
ds

 w
hi

ch
 c

on
ta

in
 th

e 
w

or
d

  “
w

in
do

w
”.

 S
el

ec
t C

om
m

an
d 

A
pr

op
os

... f
ro

m
  t

he
 H

el
p 

M
en

u.
 T

he
 m

in
i-b

uf
fe

r 
w

ill
 p

ro
m

pt
  f

or
 a

 k
ey

w
or

d,
 ty

pe
 w
in

do
w

 a
nd

 p
re

ss
 th

e
  r

et
ur

n 
ke

y. 
A

ll 
co

m
m

an
ds

 w
hi

ch
 c

on
ta

in
 th

at
  w

or
d 

w
ill

 b
e 

di
sp

la
ye

d 
in

 a
 n

ew
 b

uf
fe

r.
• 

F
in

d 
th

e 
na

m
e 

an
d 

de
sc

rip
tio

n 
of

 a
 fu

nc
tio

n
  w

hi
ch

 is
 b

ou
nd

 to
 a

 k
ey

 s
eq

ue
nc

e 
by

 s
el

ec
tin

g
  D

es
cr

ib
e 

K
ey

... f
ro

m
 th

e H
el

p 
M

en
u.

 T
he

 m
in

i-
  b

uf
fe

r 
w

ill
 p

ro
m

pt
 fo

r 
a 

ke
y,

 en
te

r 
a 

ke
y 

fr
om

  t
he

 k
ey

bo
ar

d a
nd

 pr
es

s 
th

e 
re

tu
rn

 k
ey.

 T
he

  r
es

ul
ts

 w
ill

 b
e 

di
sp

la
ye

d 
in

 a
 n

ew
 b

uf
fe

r.
• 

U
se

 th
e 

co
m

m
an

d C
-x

 p
 to

 d
is

pl
ay

 th
e 

qu
ic

k
  l

is
t.

10

E
m

a
cs

 h
a

s 
a

 la
rg

e
 h

e
lp

 s
ys

te
m

 w
h

ic
h

 in
cl

u
d

e
s

co
m

p
le

te
 d

o
cu

m
e

n
ta

tio
n

 o
n

 e
a

ch
 o

f 
its

 f
u

n
ct

io
n

s.



APPENDIX A: USING THE MOUSE
Dragging, Scrolling, & SelectingPointing & Clicking

Dragging
Moving the mouse while simultaneously

pressing a mouse button is called dragging.
Dragging is used for selecting regions, pull-
down menus, and scrolling.

Selecting Regions
Identify the region of text you wish to

select, then move the on-screen arrow in front
of the first character. Click and hold the left
mouse button while dragging the arrow across
the region. The region highlights (in reverse
video) as it is selected but will return to nor-
mal when the mouse button is released. Re-
lease the mouse button when the region is
highlighted.

Another way to select regions is to click
the left button at the beginning and the right
button at the end of a region. The selected text
will also be copied to the kill ring.

Pull-Down Menus
Pull-Down menus are found along the

top of the Emacs frame. Buffers, File, Edit and
Help are all pull-down menus. Move the on-
screen arrow to point to the name of a menu
then click and drag the mouse downward un-
til the desired command is selected. The com-
mands will be “boxed” as the arrow passed
over.

Some commands can only be executed
at certain times; when not available they ap-
pear as greyed-out text in the menu.

Scrolling
Scrolling is necessary since only a por-

tion of the buffer can be displayed on-screen
in the Emacs window. The scroll bar and scroll
box on the right side of the Emacs window
allow easy traversal of the text buffer. There
are 3 scrolling methods, each requiring the
pointer to be located within the scroll bar.

• Scrolling Up: Click the left mouse
  button to scroll towards the beginning
  of the buffer.
• Scrolling Down: Click the right
  mouse button to scroll towards the
  bottom of  the text buffer
• Elevator Scrolling: Click and hold the
  middle mouse button while dragging
  the mouse up and down within the
  scroll bar

SCROLL BAR
Located on the right side of

the Emacs window. The pointer
must be placed within the scroll

bar to use the three different
scrolling methods.

The I-beam (right) is used for position-
ing the cursor (left) within the text buffer.

Cursor movement is accomplished by a
combination of pointing and clicking actions.
The example below shows how to move the
cursor from its current position (after the pe-
riod in the sentence “Hello World.”) to a new
location (between the two words).

• Move the on-screen I-beam pointer
  between the words “Hello” and
  “World” as shown below:

• Click the left mouse button to move the
  cursor to this new location.

The cursor does not follow the I-beam
nor does it move to the I-beam’s location until
the mouse button is clicked. Be careful not to
click the mouse button too soon while the I-
beam is still moving. This is called dragging
(moving the mouse and clicking at the same
time) and is detailed in the following para-
graph. 11

SCROLL BOX
Sometimes called an elevator, it is
located within the scroll bar. The

box’s location within the bar
indicates the cursor’s location

within the text buffer. A scroll box
which is near the top of the bar
means that the text window’s

display is toward the beginning of
the buffer.
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